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Lecture 7:  RSM Pre-processing Using the RSM GIS Toolbar 

This Regional Simulation Model (RSM) training session introduces the RSM Graphical User Interface 

(GUI). As part of this lesson, you will learn more about the custom tools available with the GIS 

ToolBar as well as the RSM Python Toolbar, which will make setting up an RSM scenario much 

easier. 

  

RSM Pre-processingRSM Pre-processing
Using the RSM GIS ToolbarUsing the RSM GIS Toolbar
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NOTE: 

 

Prerequisite: 

This training and the tools that will be used require some basic GIS 
experience. You will also need an active ArcInfo CITRIX account so you can 
access ArcGIS 9.1 via the CITRIX server.  

The HESM team at the South Florida Water Management District uses the GIS 
to manage spatial data. We have custom utilities that generate XML files that 
are then used as input to the RSM. 

 

Additional Resources 

Three video files are proved for those modelers who do not have access to 
ArcInfo GIS Software. 
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After completing this training module you will: 

 Be able to create your own copy of the RSM personal geodatabase 

 Set up features in the database for a modeling scenario 

 Generate the input files needed to run the RSM 

 Gain an understanding of how to use the RSM Toolbar 

 

NOTE:  If you do not have access to ArcGIS, the screen captures provided in this lecture 

are sufficient for reviewing basic features and lesson examples. 
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Class ObjectivesClass Objectives

 Make a copy of the RSM personal geodatabase.

 Activate the RSM GIS Toolbar

 Examine and change GIS attributes

 Perform geo-processing to set up hydrologic features in the 
database

 Generate XML files to be used as input to the RSM

 Generate RSM index files

 Examine what’s in an RSM Scenario

 Learn how to import a new GMS mesh into the RSM 
geodatabase

 Review canal network attributes

 Segment a canal

 Make a copy of the RSM personal geodatabase.

 Activate the RSM GIS Toolbar

 Examine and change GIS attributes

 Perform geo-processing to set up hydrologic features in the 
database

 Generate XML files to be used as input to the RSM

 Generate RSM index files

 Examine what’s in an RSM Scenario

 Learn how to import a new GMS mesh into the RSM 
geodatabase

 Review canal network attributes

 Segment a canal
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Anatomy of a Scenario and Introduction of the GUIAnatomy of a Scenario and Introduction of the GUI
What’s in a scenario
What’s in the GUI
Support Resources

What’s in a scenario
What’s in the GUI
Support Resources
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The RSM Graphical User Interface (GUI) currently consists of two toolbars: 

1. The GIS ToolBar 
2. The RSMGUI Python Toolbar 

 

The Geographic Information System (GIS) ToolBar organizes a set of tools developed to run inside 

ArcGIS (9.2) to assist with generating input files for the Regional Simulation Model. The ArcGIS 

software is the South Florida Water Management District HESM’s designated (spatial) database for 

storing RSM geographic features: structures, canals, boundaries, mesh. 

The RSMGUI Toolbar organizes a set of tools developed to execute the RSM and post‐process the 

output from the model. The RSMGUI uses Python, a platform independent programming language 

that can be deployed on any operating system. 

Both toolbars are intended to help simplify some of the repetitive steps for setting up an RSM scenario 

in a self‐documenting environment. The HESM team plans to complete a set of tools that will help 

build a scenario from beginning to end. 
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What is the RSM GUI?What is the RSM GUI?

The GIS Toolbar

The RSMGUI
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The RSM GIS ToolBar contains several tools to help configure the geodatabase and generate input 

files for the RSM. 

The RSM geodatabase contains all of the data used to specify the physical features represented in the 

model. The geodatabase helps visualize the physical features in your model during setup and it 

serves as a documented source of data during post‐processing.  And, flexible RSM tools enable you to 

generate more than one type of file and output format. 

Tools are organized by the main physical elements in the RSM: MESH, HSE Network, MSE, HPMs, 

GENERATING XMLs, Utilities and HELP.  

NOTE:  Some features may not yet be active. New features will continue to be created 

and updated. 
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The GIS ToolbarThe GIS Toolbar
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The basic workflow to set up an RSM scenario using the GIS tools is outlined below: 

 Generate a mesh using GMS 

 Export the GMS to a .2DM file 

 Import the .2Dm into GIS to generate a GIS mesh layer 

 Combine the mesh layer with the base layers in the RSM geodatabase template* 

 Intersect the mesh layer with other attribute information 

 Configure the HSE canal network 

 Configure the watermovers (structures) 

 Add new canals 

 Add new watermovers 

 Configure boundary conditions 

 Configure the MSE water control units 

 Configure the HPMs 

 Segment the canals 

 Generate the RSM input files 
 
*  /data/geographic/geodatabase_templates/mesh_import_template.mdb 
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GIS WorkflowGIS Workflow

Import GMS Mesh to GIS

Prepare RSM GIS Geodatabase
•Intersect Mesh w/ surfaces

•Adjust canal attributes
•Adjust Watermover attributes

•Adjust mesh attributes
•Assign Boundary Conditions
•Assemble WaterControlUnits

•Add canal features
•Modify canal network

•Add watermovers
•Segment canal network

Generate RSM Input Files
•Network XML

•Watermover XML
•BC XML

•MSE XML
•Other XMLs…

•.map file
•Index .dat files

.xml
files

Prepare Mesh (GMS)
(see Mesh How-to Document)

.2dm
Binary

file

RUN THE MODEL
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GIS via CITRIX and the RSM GeodatabaseGIS via CITRIX and the RSM Geodatabase
Starting GIS via Citrix The RSM Geodatabase
Selecting Features Changing Attributes
Starting GIS via Citrix The RSM Geodatabase
Selecting Features Changing Attributes
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Open your own copy of the RSM personal geodatabase (a copy has been stored under 

$RSM/labs/lab8_RSMtoolbar/c111.mdb). And, become familiar with some of the basic GIS 

features, including the: 

 Data layer index (right side) 

 “Arrow at end” symbol which allows you to view canal default direction 

 Mesh cells, which are polygons, have attributes which have been acquired from other data layers 

 Watermovers (structures) which have associated tables describing the units at each structure in very 
specific detail 

 Information tool which you can use to view some of the attributes in the geodatabase 
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What’s In The Geodatabase?What’s In The Geodatabase?

Canal reach

Mesh cell

watermover

info

GIS 
layers
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The canal network consists of individual line segments. Each segment has been assigned attributes 

describing the physical characteristics as well as the participation of each segment in the overall 

network. 

 Mesh cells contain attributes intersected from other GIS layers 

 Canals are organized into reaches. 

 Structures are fully attributed and contain associated unit tables 

Select the Information tool and click on features in the geodatabase to view their attributes. 
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Detailed Water Unit Features in the 
RSM Geodatabase
Detailed Water Unit Features in the 
RSM Geodatabase

Mesh feature

Watermover feature
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Query Data 
From the GIS drop‐down menu, choose Selection and click the option for Select by Attributes. Within 

the Select by Attributes query window: 

 Specify the structure Layer 

 Specify the [NAME] Attribute (the attribute you want to query) from the top list box 

 Click the = button to select the qualifier to make the selection 

 Click Get Unique Values to display a list of unique names 

 Select S18C from the list of unique names in the second list box 

Your query is displayed in the bottom portion of the Select by Attributes window. Your query should 

read: [NAME] = “S18C” 

The complete query is: Select * from Structure WHERE Name = “S18C” 
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Selecting and Viewing GIS DataSelecting and Viewing GIS Data

SELECT * FROM structure WHERE NAME = ‘S18C’
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Editing 
Before you can make changes to attributes in the geodatabase, you must be in an Edit Session:  

1. From the Tools drop-down menu, select the Editor Toolbar and click Start Editing. 
2. Right-click the Structure layer in the list of Layers (on the left side of your screen) and select View 

Attribute Table. 
3. Structure S18C should be highlighted in the list of structures. Click the Enabled field and examine the 

choices. 

Some fields are set up as domains, which helps to ensure that only valid data values are entered. The 

Enabled field has three optional values (True, False, and NULL). 
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Viewing and Changing AttributesViewing and Changing Attributes

*Must be in an 
Edit Session to
Make changes

Editor
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The RSM GIS ToolbarThe RSM GIS Toolbar
Load the Toolbar
Collection of Tools
The Tools

Load the Toolbar
Collection of Tools
The Tools
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Installing the RSM GIS ToolBar 
To install the RSM GIS ToolBar to your ArcMap GIS Desktop: 

1. Select the Customize option from the Tools dropdown menu at the top of the screen 
2. Select RSM GIS ToolBar v4.3 from the list of choices available in the Toolbars tab 
3. When the RSM GIS ToolBar button appears, you can drag and anchor it to your Main Menu bar in ArcMap 

Click on the new RSM GIS ToolBar button and the toolbar will open. It will not be necessary to repeat 

this installation procedure. The next time you start ArcMap, the RSM GIS ToolBar will be ready to 

use. 
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Activating the RSM GIS ToolbarActivating the RSM GIS Toolbar

Button to activate RSM GIS Toolbar
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The RSM GIS Tools are organized by major RSM category and workflow functions to: 

 Import a mesh and manage the elements in the mesh (cells) 

 Set-up features in the canal network (segments) 

 Set-up features for each watermover (structures) 

 Generate your RSM XML files 

There is also a menu for other utilities and for Help. 
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Organization of the RSM GIS ToolsOrganization of the RSM GIS Tools
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Mesh ToolsMesh Tools
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Import a Mesh 

The Import .2dm File feature has been redesigned to import an existing GMS .2dm mesh and then 

incorporate it into the RSM geodatabase template. The new tool also immediately opens the new 

mesh and geodatabase in a GIS map session.  The projection is defaulted to 

NAD_1983_HARN_StatePlane_Florida_East. 

There are two methods to import a mesh: simple or using the RSM template. The following steps 

demonstrate using the RSM Template method: 

1. Select Import Mesh from the Mesh drop-down menu and click Load SFRSM Template 
2. Load Input .2DM Mesh File (file created in GMS) 
3. Load Input FrameWork Shapefile (shapefile used to create mesh) 
4. Select name and location of Output Geodatabase 

The result will be a RSM geodatabase with the correct format for use with the RSM GIS GUI Tools for 

south Florida. Canals falling completely outside the framework are removed. Additional editing is 

required to clean canals that extend beyond the framework.  
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Import .2dm FileImport .2dm File

Select Output 
Geodatabase

Load Framework 
Shapefile

Load .2dm file 

Select the Import Mesh Tool
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When working within a new map, it may be necessary to import your mesh for the first time. 

1. Right-click the Layer menu to the left of the map display window and select Add Data from the menu. 
2. Browse to the location where your mesh has been saved. 
3. Select the .mdb file to be added to the map. 
 

An RSM Mesh must contain: 

 A mesh_framework 

 Mesh  

 Mesh_pnt 

 Mesh_bnd 

 Mesh_node layers 
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Add Mesh Layers (data) to Your MapAdd Mesh Layers (data) to Your Map
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RSM GeodatabaseRSM Geodatabase

Populate Mesh Attributes:

 Use RSM GIS GUI toolbar

 Mesh Dropdown menu  >> Intersect Mesh

 Select mesh input for overlay

 Overlay data generally consist of:

• Physical land or aquifer properties

• Cell groups such as HPM Hubs, k zones, or WCDs

Populate Mesh Attributes:

 Use RSM GIS GUI toolbar

 Mesh Dropdown menu  >> Intersect Mesh

 Select mesh input for overlay

 Overlay data generally consist of:

• Physical land or aquifer properties

• Cell groups such as HPM Hubs, k zones, or WCDs
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This slide shows an example of the results from importing a new mesh using the RSM Template. 

 Note the canals extending beyond the framework. 

 Note a new line symbol was chosen to display the canals to help view the default flow direction. 
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A Mesh Intersect Tool, available from the Mesh drop‐down menu, helps you intersect your mesh 

with other data layers. It will populate the mesh with attributes needed by the RSM and utilized for 

generating index files. 

NOTE: The path $RSM/data/geographic will work if you are not on the SFWMD 

network. 
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RSM GeodatabaseRSM Geodatabase

Populate Mesh Attributes:

 Select layers and overlay type

• Topography

• Land Use

• Hydraulic Conductivity

• Bottom Elevation of Layer 1

• etc…

 Model data for overlay can be found at

\\dcluster1\oom\sfrsm\data\geographic

 Old data is archived here so always use the latest 
version

Populate Mesh Attributes:

 Select layers and overlay type

• Topography

• Land Use

• Hydraulic Conductivity

• Bottom Elevation of Layer 1

• etc…

 Model data for overlay can be found at

\\dcluster1\oom\sfrsm\data\geographic

 Old data is archived here so always use the latest 
version
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Intersect the mesh with other data layers to incorporate other data into the mesh as new attributes. 

Drop‐down menus guide your selection of a method of intersection and the attribute layers to be 

added to your mesh. 

 Raster data such as topography are intersected using Zonal Range 

 Point data such as wells are intersected using Mesh Centered 

 Polygon data such as landuse are intersected using Mesh Centered 
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Mesh Intersect ToolMesh Intersect Tool

1. Select the desired Mesh

4. Select overlay type

3. Select field containing 
overlay attributes

2. Browse to overlay dataset 
(raster or polygon) 

5. Enter new field name
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The Zonal Mean process works well for smooth continuous data. Zonal Mean does not work for 

categorical data like landuse. For topography data it is possible to have bad data such as buildings or 

missed data, but Zonal Mean is the method most often used. 

The Zonal Majority process works well for landuse data and other categorical data. If there is a 

landuse that is more important, it may be best to manually adjust the landuse selections. 

For groups such as hubs or watersheds, the Mesh Centered process works well. 
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Mesh Intersect ToolMesh Intersect Tool

 Mesh attributes

• Use Zonal Mean Process method for the following:

 Topography

 Hydraulic Conductivity

 Bottom of the Aquifer

• Use Zonal Majority Process method for landuse or 
vegetation

• Use Mesh Centered Process Method for defining mesh 
groups such as HUBs, WCDs, k zones or watersheds

 Mesh attributes

• Use Zonal Mean Process method for the following:

 Topography

 Hydraulic Conductivity

 Bottom of the Aquifer

• Use Zonal Majority Process method for landuse or 
vegetation

• Use Mesh Centered Process Method for defining mesh 
groups such as HUBs, WCDs, k zones or watersheds
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Mesh Zones are useful for large areas that have the same categorical value such as hubs or Water 

Control Districts (WCDs). Parameters such as hydraulic conductivity that have widely varying values 

may be grouped into ranges that can be assigned a single value in the model. This is useful in 

calibration. 
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Assigning Mesh ZonesAssigning Mesh Zones

Mesh Zones

 Mesh Zones may be defined in the following cases:

• HPM Hubs

• WCDs (Water Control Districts)

• Hydraulic Conductivity Zones

 Mesh Zones become indexed entry values in the 
model

Mesh Zones

 Mesh Zones may be defined in the following cases:

• HPM Hubs

• WCDs (Water Control Districts)

• Hydraulic Conductivity Zones

 Mesh Zones become indexed entry values in the 
model
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This slide presents an example of hydraulic conductivity zones used in the C‐111 RSM 

implementation. 
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Map of Mesh Calibration Zones (C-111 SC)Map of Mesh Calibration Zones (C-111 SC)
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The RSM GIS Toolbar HSE Canal Network ToolsThe RSM GIS Toolbar HSE Canal Network Tools
Examine Canal Attributes
Add/Modify a Canal
Segment Canals

Examine Canal Attributes
Add/Modify a Canal
Segment Canals
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The HSE Network tools drop‐down menu includes the Import GMS Canal function and Generate 

Canal Attributes function, which are not active at this time and will not be covered in this training. 
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HSE Network ToolsHSE Network Tools
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Viewing and Editing Attributes 
In the Display window on the right side of the screen, right click the Canal Layer, then select View 

Attribute Table from the list of options. 

When the attribute table appears, click the button Show: Selected at the bottom of the window, to 

view the attributes for the canal reach you selected. 

There are four canal segments in Reach 608. Look at some of the attributes to become familiar with the 

level of detail in the RSM geodatabase. Notice the attribute called “segmented” = yes. This means this 

canal has already been segmented. Notice that each segment in Reach 608 is the same length.  

To change one of the attributes, open an Edit Session: 

1. Click on the Editor button at the top of the GIS display window 
2. Select Start Editing from the choices you are given 
 

Some attributes are text fields that can be changed (name) and some have drop‐down lists offering 

specific value choices (enabled). Others have restrictions on the range you can enter (e.g., Mannings). 
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View the Canal Attribute TableView the Canal Attribute Table
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The standard GIS tools can be used to select features in the geodatabase and view attributes. The 

easiest way to view attributes is to use the Information Tool. Select the  GIS Information Tool and 

click a feature in your map.  

Helpful terms: 

 A canal is a waterbody we know by name, like C-111 

 Segments are pieces of a canal 

 A reach is a group of similar segments bounded by a canal junction 

 A stage reach is a group of reaches bounded by an upstream and downstream structure 
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Examine the Canal AttributesExamine the Canal Attributes
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To start with the database schema required in order for all of the RSM GIS tools to work properly, 

start with the RSM geodatabase template. Delete all of the data and then repopulate the geodatabase 

tables with new data. 
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Add Canal AttributesAdd Canal Attributes

Using the ArcGIS Editor Tools  new canals can be added to a 
geodatabase.  By working within an existing geodatabase
schema all the attribute fields and relationships will already be 
present.
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Select a Canal Reach 
Select a canal reach using the standard GIS Selection Tool:  

 Selection > Select by Attribute 

 Select the canal layer 

 Select the reach attribute 

 Click the button for Get Unique Values 

 Create a query by clicking the items to add to the window at the bottom of the tool 

 Select * from canal WHERE reach = ’608’ 

Reach 608 will be selected, and you can review its attributes. 
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Select a Canal ReachSelect a Canal Reach
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The Mesh Import Tool cuts features (with the exception of canals) to the edge of the model. To 

maintain canal ID values, canals extend the next full segment beyond the edge of the mesh. A 

structure (most likely a boundary condition for the canal) may be located at the end of a segment. 

Boundary condition files are used with the structure information with the new model. You want to 

keep structures at the ends of segments.  

This practice also applies to canals that exit and re‐enter the mesh. Rather than cutting the segment, 

the modeler preserves it and then moves the coordinates of the segment back into the mesh. 

Segments should not end outside the model mesh. Check for canal connectivity to be sure that the 

canals are connected correctly. Make sure structures and canals are appropriately enabled. If canal 

segments are not needed, disable the canals or structures instead of deleting the segments. (Disabling 

the canals changes the segment IDs.)  

When the canal network is changed, you need to create a new *.MAP file, arc.index file, and initial 

conditions files. Although the model will run with the incorrect files, the results will be wrong. So, 

review the canal parameters to verify values are correct. 
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Canal and Structure EditsCanal and Structure Edits

 Make necessary canal edits

• Snap canals to model boundary

• Check for proper connectivity

• Make sure the appropriate canals are enabled

• Review canal parameters

• Assign canal zone parameters

• Levee seepage canals (yes or no)

 Make necessary canal edits

• Snap canals to model boundary

• Check for proper connectivity

• Make sure the appropriate canals are enabled

• Review canal parameters

• Assign canal zone parameters

• Levee seepage canals (yes or no)
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To build the canal IDs, use the ArcGIS objectIDs. ObjectIDs are intrinsic variables in ArcGIS that 

cannot be modified. Add 300,000 to obtain the segment IDs. This numbering convention assures that 

segment waterbodies are unique.  

If you cut segment 300,001 and create a new segment, you cannot label the new segment 300,002 and 

keep the old segment as 300,001. This is because ArcGIS recognizes the two new segments and 

assigns new objectIDs (in this case new canalIDs) to the segments. The actual numbers are added to 

the bottom of the list of segment IDs.  

In this case, the segment 300,001 no longer exists. Be careful not to use canalID 300,001 because that 

value refers to a longer segment that is no longer valid. However, canalID 300,001 may still be valid in 

a version of the model in use by another modeler.  

NOTE:  When using boundary condition files, you will need to manually check for any 

instance where 300,001 was used and change that boundary condition ID. 

Although, disabled segments maintain their objectID and canalIDs, they are not used in the map file. 
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Canal EditsCanal Edits

300001

300002 300003
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To Segment a Reach: 
1. Select by Attribute feature: 
2. Select Reach=‘608’ from the canal layer.  
3. Use the Segmentation Tool from the RSM GIS ToolBar to re-segment this reach into one mile segments. 
4. From the RSM GIS ToolBar, choose the Segment Canals tool from the HSE Network Menu.  
5. Zoom to the selected canal reach: click the Selection Menu at the top of the GIS window and choose the 

Zoom to Selected Feature option. 
6. Segment a single reach (which currently consists of 3 segments), dividing it into 1-mile long segments. 
7. Use a Minimum setting of 3,000 feet, Maximum setting of 8,000 feet and a Target setting of 5,280 feet (in 

order to get one-mile segments).  
8. Accept 2 as the default for forcing a minimum of two segments to prevent inadvertently merging the reach 

into one segment. 
9. An optimum length has been calculated using the selected range and target so no tiny segments will result 

due to a small remainder.  
10. Reach 608 will now be segmented into 5031.72803196363 foot segments.  
11. Click the Segment Interactively button. 
12. When the optimum length is calculated, click the [OK] command. 
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Min/Max/Target SettingsMin/Max/Target Settings
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Reach 608 has been segmented into four equal segments. 

By right‐clicking on the canal layer in the layers index on the left side of the screen, the line type can 

be changed to display “arrow at end.”  This will display an arrow showing flow direction at each 

segment. 
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Segmented CanalSegmented Canal

Reach 608
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Segment an Entire Canal Network 
A canal network with 14,000 segments can be segmented in approximately 5 minutes. 

The Segment Automatically button enables you to segment an entire canal network in the 

geodatabase all at once. When the Forced Segmentation check box is selected in the Segmentation 

Tool dialog box, the Segment Automatically option forces segmentation to take place even if the 

minimum, maximum and target settings specified would not result in any action. 

For example, if a canal is too small to be segmented according to the minimum, maximum and target 

settings specified, when the Forced Segmentation check box is selected (under Automatic 

Segmentation) and the Min. Number of Segment box value is “2”, the canal will be split into two 

equal segments regardless of its size. 

This tool applies a weighted calculation from Dr. Wasantha Lal, which ensures mass is preserved in 

the resulting segmented canal. (The Manning’s, volume, depths, roughness and slopes are all 

properly distributed to the new segments.) 
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Min/Max/Target SettingsMin/Max/Target Settings

Forced split into 
minimum of 2 

segments

Merged Shorter 
Segments
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Canal files typically cause the majority of problems modelers encounter using the RSM setup. 

 Canal geometry file: .MAP 

 Initial conditions:      initial.dat, sequential list of values by canalID 

 Arc index files:         arcs.dat, sequential list of values  

The .MAP file contains the geometry of the nodes for the segments. When modifying the geometry of 

the canal network it is tempting to edit the map file manually. While manual editing is relatively easy 

to do, it is not a recommended practice because the resulting model canal geometry file will no longer 

match the information in the geodatabase. 

The index files do not contain the canalIDs; values must be adjusted very carefully when creating new 

canal segments.  

Currently no utility exists to import .MAP files into ArcGIS. The .MAP file can be viewed in GMS and 

then exported as a Shapefile. The RSMGUI post‐processor reads the netCDF output file from the RSM. 

The post‐processor can display exactly what the model sees, including the mesh cells and canals. 
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Build Canal Input DatasetsBuild Canal Input Datasets

Typical Canal Input Files:

 Canal.map (stores canal geometry data)

 Canal index file (stores canal zone data for 
indexed entry)

 Canal start head file (stores canal initial condition 
file)

Typical Canal Input Files:

 Canal.map (stores canal geometry data)

 Canal index file (stores canal zone data for 
indexed entry)

 Canal start head file (stores canal initial condition 
file)
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The Index Tool is a generic tool for writing index files. For this application, it is used to generate 

index files for the canal network and the mesh. The output from this tool is an ASCII (.dat) file 

containing a sorted list for any RSM attribute. 

Select a database layer, then select an associated attribute and specify the desired header format. The 

index headers are specific for the type of index files you are creating. This tool automatically filters 

out and ignores any disabled features in the geodatabase. The tool will prompt you for an output file 

each time it is run. 

To create the initial head index file, it is first necessary to create an attribute for the canal segments 

containing the initial head stage. Since this tool does not have the functionality for performing 

attribute field calculations, it is necessary to create a new field in order to make calculations (which 

can then be used to generate an initial head index file).  

Using this tool, you can create several attribute index files, including: topo.dat, bot_lyr.dat, 

hyd_con.dat, mann_prop.dat, sv.index, landuse95.dat, and more. 
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Building Index FilesBuilding Index Files

Select Feature 
Class Mesh

Select desired 
attribute

Choose Header

Select Appropriate Header:

• Main Header for mesh index 
files

• Canal Index Header for 
canal index files

• Canal Start Header for canal 
initial condition file
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To create a canal.map file, select the Canal File (.MAP) option in the Generate XML Menu available 

in the RSM GISToolBar. 
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Canal .MAP FileCanal .MAP File
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Select the geodatabase Canal Feature class that contains the canal line work and attributes.  

NOTE:  Segments for canals and watermovers are enabled and disabled. Use filters to 

provide only the canal type=1 and enabled=1. 

Next, select the attributes for the .MAP file. The Variable Options fields may be changed if you want 

to work with experimental values. The default is to use the variables which are part of the standard 

RSM geodatabase, which will produce the correct map files to be read by the RSM. 
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Canal .MAP FileCanal .MAP File

Select canal 
Feature Class

Select Output File 
Location

Assign 
Attribute 
Mapping

Filter to get only 
enabled canals

Filter to exclude 
watermover
segments
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A single‐click tool generates the canal.map file used by the model.  The file contains all the 

information about each segment in your geodatabase. 

 Beginning point (x,y) 

 End point (x,y) 

 ID 
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Canal .MAP FileCanal .MAP File

This file describes the x,y and length of the 
segments in the canal network.
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The framework was created to provide the flow boundaries for the mesh. There is a tool that selects 

the nodes and creates the necessary boundary files. Levees are collections of nodes along the model 

framework. 

Within the XML there are three important attributes: Enabled, No Flow, and Boundary. 

The Levee Seepage feature will create the necessary watermovers.  

For the Levee Seepage watermover, select “ol/gw” and turn off the default overland flow and 

groundwater flow watermovers.  

To visualize the boundaries, symbolize the framework feature class on the boundary field and the 

boundary conditions will show in a map. 
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Assign Levee Properties to FrameworkAssign Levee Properties to Framework

Framework / Levee Attributes:

 Enabled = 1 (yes)

 No Flow = “yes”

 Boundary = 

• “ol” (No Overland Flow)

• “gw” (No Groundwater Flow)

• “ol/gw” (No Overland or Groundwater Flow)

• “none” (No Boundary Condition)

*** Assign Domain to boundary field (GUI TOOL BUG)

*** Use “ol/gw” for Levee Seepage (turn off default flow)

Framework / Levee Attributes:

 Enabled = 1 (yes)

 No Flow = “yes”

 Boundary = 

• “ol” (No Overland Flow)

• “gw” (No Groundwater Flow)

• “ol/gw” (No Overland or Groundwater Flow)

• “none” (No Boundary Condition)

*** Assign Domain to boundary field (GUI TOOL BUG)

*** Use “ol/gw” for Levee Seepage (turn off default flow)
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This is a map of the Levee feature class. 
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Assign Levee Properties to FrameworkAssign Levee Properties to Framework

No Overland Flow

No Overland or 
Groundwater Flow

Framework Line



RSM Training   HESM Instructional Materials for Training Purposes Only 
Module 7: RSM Pre-processing Using the RSM GIS Toolbar 

 
 

Page 7.44  Hydrologic and Environmental Systems Modeling 

This is now the Levee Seepage Boundary Condition. Reminder: load the entire geodatabase when you 

load the data.  

 

NOTE:  This area is under development and may look different from what you see on the 

slide** 
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Build Levee Boundary Condition FileBuild Levee Boundary Condition File

Load entire 
geodatabase and 

start editing before 
selecting Yes

Browse to file 
save location.
Delete top line 
for model use.
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The GIS Levee Seepage tool on the Generate XML Menu extracts the data from the geodatabase 

attribute files and creates an ASCII table that contains the necessary data for the Levee Seepage .XML 

file. 
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Levee Seepage ExampleLevee Seepage Example

<!-- seepage across C-111, from S-18C to S-197 (extrapolated from S-177 to 18C) -->

<leveeSeepage>

<MarshCellToDryCell MarshCellId="2133" DryCellId="2132"   K_md="3.1300000E-05" 
wmID="604206" length="330" />

<MarshCellToSegment MarshCellId="2133" SegmentId="309558" K_ms="9.4955613E-
03" wmID="604207" length="330" />

<DryCellToSegment DryCellId=  "2132" SegmentId="309558" K_ds="1.0571970E-02" 
wmID="604208" length="330" />

</leveeSeepage>

<leveeSeepage>

<MarshCellToDryCell MarshCellId="2133" DryCellId="2132"   K_md="3.1300000E-05" 
wmID="604209" length="1206" />

<MarshCellToSegment MarshCellId="2133" SegmentId="309558" K_ms="9.4955613E-
03" wmID="604210" length="1206" />

<DryCellToSegment DryCellId=  "2132" SegmentId="309558" K_ds="1.0571970E-02" 
wmID="604211" length="1206" />

</leveeSeepage>

<!-- seepage across C-111, from S-18C to S-197 (extrapolated from S-177 to 18C) -->

<leveeSeepage>

<MarshCellToDryCell MarshCellId="2133" DryCellId="2132"   K_md="3.1300000E-05" 
wmID="604206" length="330" />

<MarshCellToSegment MarshCellId="2133" SegmentId="309558" K_ms="9.4955613E-
03" wmID="604207" length="330" />

<DryCellToSegment DryCellId=  "2132" SegmentId="309558" K_ds="1.0571970E-02" 
wmID="604208" length="330" />

</leveeSeepage>

<leveeSeepage>

<MarshCellToDryCell MarshCellId="2133" DryCellId="2132"   K_md="3.1300000E-05" 
wmID="604209" length="1206" />

<MarshCellToSegment MarshCellId="2133" SegmentId="309558" K_ms="9.4955613E-
03" wmID="604210" length="1206" />

<DryCellToSegment DryCellId=  "2132" SegmentId="309558" K_ds="1.0571970E-02" 
wmID="604211" length="1206" />

</leveeSeepage>
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To complete a spatial “join” in GIS: 

 Right-click the PWS shapefile name (the selected layer in the left-window shown in the slide above). 

 Select Joins and Relates > Join 
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Public Water Supply Boundary Condition 
(PWS BC) 
Public Water Supply Boundary Condition 
(PWS BC) 

Right click on pws
shapefile and 

select Join
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Adds cellIDs to the Shapefile using Join Data: 

1. In the Join dropdown menu, select “Join data from another layer based on spatial location” (refer to slide 
above) 

2. Select “Mesh” for Option 1 
3. Click the “It falls inside” option button (located below Option 2) 
4. Browse to the output directory and choose a file for Option 3 
5. Click the [OK] command 

 

 

46

Public Water Supply Boundary Condition 
(PWS BC)
Public Water Supply Boundary Condition 
(PWS BC)

Drop down and 
select the spatial 
location option

Select Mesh

Select Falls Inside

Select output 
location for new 

shapefile
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(Steps for constructing the PWS.xml file are described on the following slides.) 

 

 

47

Public Water Supply Boundary Condition 
(PWS BC)
Public Water Supply Boundary Condition 
(PWS BC)

Create the PWS.xml file:

 Add PWS shapefile to ArcGIS

\\dcluster1\oom\sfrsm\data\geographic\pws\pws_CalibVerif_v2.shp

 Use GIS to get cellids and build table

 Export the table and format table in MS Excel

 Run PWS tool on the RSMGUI 

Create the PWS.xml file:

 Add PWS shapefile to ArcGIS

\\dcluster1\oom\sfrsm\data\geographic\pws\pws_CalibVerif_v2.shp

 Use GIS to get cellids and build table

 Export the table and format table in MS Excel

 Run PWS tool on the RSMGUI 
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Pumping data has been compiled for the period 1980 to 2000 into standard RSM data sets. Data 

required for creating the pws.xml file, includes: 

 Type: Instantaneous, period average, or cumulative flow. (For flow, period average is the preferred 
data so that DSSVue methods work correctly.) 

 Multiplier: Converts the data from the native units into the model units. (If this step is overlooked, the 
model will still run, but the results will be incorrect.) 
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Public Water Supply Boundary Condition 
(PWS BC)
Public Water Supply Boundary Condition 
(PWS BC)

PWS Input File:

 wellid (needs to be a unique id across all inputs) 

 cellid (cell that contains the well)

 Label (permit # ??)

 DSS file (path to dss file with pumping data)

 Units (units for the pumping data)

 Type (type of value)

 Mult (conversion multiplier)

PWS Input File:

 wellid (needs to be a unique id across all inputs) 

 cellid (cell that contains the well)

 Label (permit # ??)

 DSS file (path to dss file with pumping data)

 Units (units for the pumping data)

 Type (type of value)

 Mult (conversion multiplier)
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Edit the Shapefile attribute table to remove all of the PWS wells that have no value in the cellID field 

(wells outside of your mesh). Export the Shapefile .dbf file to Microsoft Excel to remove the unneeded 

wells and all of the fields except the cellID and the wellID fields. 
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Public Water Supply Boundary Condition 
(PWS BC)
Public Water Supply Boundary Condition 
(PWS BC)

PWS file with mesh Cellids:

 Delete wells from new shapefile that do not 
contain cellid values (outside the model)

 Export attribute table to MS Excel (use xtools or 
export to dbf)

 In Excel delete “extra” fields

 Make .csv file with wellid, cellid only

 Run the RSMGUI

PWS file with mesh Cellids:

 Delete wells from new shapefile that do not 
contain cellid values (outside the model)

 Export attribute table to MS Excel (use xtools or 
export to dbf)

 In Excel delete “extra” fields

 Make .csv file with wellid, cellid only

 Run the RSMGUI
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The RSM GIS Toolbar GENERATE XMLsThe RSM GIS Toolbar GENERATE XMLs
Index Tool MSE XMLs
Watermover XML Junction Block XML
Boundary Condition XML Canal File (.MAP)

Index Tool MSE XMLs
Watermover XML Junction Block XML
Boundary Condition XML Canal File (.MAP)
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Your geodatabase is now the source (origin, repository, master data source, record of authority) for all 

the physical information that will be used by the RSM. 

You can generate the input files for an RSM model implementation.  

These are all SINGLE CLICK tools which automatically assemble the information into the format that 

is dictated to us via the DTD file. 
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Generate XMLs/Files ToolsGenerate XMLs/Files Tools
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The Build Watermover and Junction Block XML routine traverses the canal network, finds the 

structures, identifies the upstream and downstream canalIDs and goes into the attribute table and 

identifies the structure type (e.g., culvert, weir, and pump). It assumes that your canal network is 

perfect. 

This routine creates a junction block for each structure and creates the appropriate XML file. (The 

junction block XML file needs to be checked carefully, errors are typically a result of errors in the 

canal network.) 

For output files, browse to the appropriate directory. 

NOTE:  If you are not on the SFWMD network, your XML files may go to another location 

based on how you installed RSM. 
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Build Watermover and Junction Block XML Build Watermover and Junction Block XML 

Watermover XML

Junction Block XML

The XML files go here. This is 
actually

\\ha1-fs1\username\RSM
The new files are named:

•Watermover.xml
•Network.xml

The Watermover XML and 
Junction Block XML files are 

used to capture upstream 
and downstream IDs.  This 

file needs editing and QA/QC 
to be used in the model!!
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For structures, there are three structure types: 

 Inline structures (between two segments) 

 Diversion structures (between a segment and cell) 

 Junction-block structures (no flow) 

NOTE:  Labeling of the junctionblocks is under development. Your file may look different 

from what is displayed here. 
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Junction Block XML ExampleJunction Block XML Example

<junctionblock id1="309506" id2="309508">

</junctionblock>

<junctionblock id1="309519" id2="310492">

</junctionblock>

<junctionblock id1="309540" id2="309546">

</junctionblock>

<junctionblock id1="309550" id2="310490">

</junctionblock>

<junctionblock id1="309530" id2="310495">

</junctionblock>

****GUI has plans to add Label = “Structure Name”

<junctionblock id1="309506" id2="309508">

</junctionblock>

<junctionblock id1="309519" id2="310492">

</junctionblock>

<junctionblock id1="309540" id2="309546">

</junctionblock>

<junctionblock id1="309550" id2="310490">

</junctionblock>

<junctionblock id1="309530" id2="310495">

</junctionblock>

****GUI has plans to add Label = “Structure Name”
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The Index Tool helps generate three different types of files: 

 Generic index file 

 Canal_index 

 Canal_start 

The files are almost identical except for the headers and a comment line at the end of the file.  

Any GIS layer attribute can be written out to an index file this way. 
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INDEX TOOLINDEX TOOL

Header options offer three different formats for output matching
requirements for the generic index file, canal_index and canal_start
files.
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The Watermovers XML is a single‐click tool that assembles an XML file containing information about 

all the watermovers in your scenario. This file was used in earlier versions of the RSM and now serves 

as a quality assurance and quality control tool for checking problems that arise in a scenario. 

 

55

The watermovers XMLThe watermovers XML
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This slide shows a snippet of a Watermovers XML file for the different structures. The attributes are 

defined in the HSE User Manual, which can be found in the $RSM/labs/lab2_BM2 directory. For a 
Junctionblock Watermover, there will be an entry in the junctionblock.xml, but not in the 

watermover.xml file. 

NOTE:  There can be multiple watermovers at each junction. This is a designed 

component of RSM that allows the modeler the ability to separately manage each structure 
with multiple culverts, pumps and weirs.  
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Watermovers XML ExampleWatermovers XML Example

<culvert id1="309558" id2="309559" label="S197-6" wmID="620128" 
width="0" height="7" length="66" mann="0.024" coeff="0.65" 
hw_inv="-8" tw_inv="-8" rev="n" />

<culvert id1="309558" id2="309559" label="S197-5" 
wmID="620127" width="0" height="7" length="66" mann="0.024" 
coeff="0.65" hw_inv="-8" tw_inv="-8" rev="n" />

<genStruc id1="309550" id2="310490" label="S18C" 
wmID="650036" design="999999" disChar="2912" a="0.5" />

<genStruc id1="311505" id2="1" label="S20" wmID="650039" 
design="999999" disChar="1149" a="0.5" />

<genStruc id1="300000" id2="300000" label="S174" 
wmID="650032" design="999999" disChar="809" a="0.5" />

<genStruc id1="309540" id2="309546" label="S177" 
wmID="650034" design="999999" disChar="1729" a="0.5" />

<culvert id1="309558" id2="309559" label="S197-6" wmID="620128" 
width="0" height="7" length="66" mann="0.024" coeff="0.65" 
hw_inv="-8" tw_inv="-8" rev="n" />

<culvert id1="309558" id2="309559" label="S197-5" 
wmID="620127" width="0" height="7" length="66" mann="0.024" 
coeff="0.65" hw_inv="-8" tw_inv="-8" rev="n" />

<genStruc id1="309550" id2="310490" label="S18C" 
wmID="650036" design="999999" disChar="2912" a="0.5" />

<genStruc id1="311505" id2="1" label="S20" wmID="650039" 
design="999999" disChar="1149" a="0.5" />

<genStruc id1="300000" id2="300000" label="S174" 
wmID="650032" design="999999" disChar="809" a="0.5" />

<genStruc id1="309540" id2="309546" label="S177" 
wmID="650034" design="999999" disChar="1729" a="0.5" />
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The Boundary Condition Tool is a single‐click tool that generates the bnd_condition XML. The 

Boundary Condition XML contains information pertaining to the boundary conditions in your 

scenario, such as: 

 Bnd_type (boundary type) 

 A sequenced list of nodes that make up the mesh boundary 

 A label containing the name of the boundary 

This tool is applied against the mesh_framework by selecting the designated boundaries and 

outputting the nodes and attributes comprising each “no flow” levee boundary. Additional boundary 

types will be added sometime in the near future. 
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The Boundary Condition XMLThe Boundary Condition XML
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The Tidal BC xml file is built manually. All of the nodes are assigned to one tide gage. 

NOTE:  For the wallghb conductivity, values should be in the range of 0.001 to 1.0. The 

calibration results from the Broward Subregional RSM indicated that the conductivity of the 
walls should be set around 10-3. In south Miami-Dade, values greater than 1.0 produced 
unreasonable cell heads near the coast, even though the cell conductivities were as high as 
10,000. 
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Tide BC ExampleTide BC Example

<wallghb value=“0.001" label = "Manatee tide record" >

<nodelist> 

1773 1754 1733 1732 1753 1730 1705 1681 1654 1623 1589 1552 1514 1474 
1430 1387 1341 1295 1245 1195 1244 1193 1139 1085 1029 1028 972 914 
854 793 791

</nodelist>

<!-- Use  Tidal stage record from   -->

<uniform> <dss file="../input/RSM_TIDES_2006.dss"

pn="/NSRSM/FLAMINGO/TIDE/01JAN1983/1DAY/SIMULATED/" 
units="ft"> </dss>

</uniform>

</wallghb>

<wallghb value=“0.001" label = "Manatee tide record" >

<nodelist> 

1773 1754 1733 1732 1753 1730 1705 1681 1654 1623 1589 1552 1514 1474 
1430 1387 1341 1295 1245 1195 1244 1193 1139 1085 1029 1028 972 914 
854 793 791

</nodelist>

<!-- Use  Tidal stage record from   -->

<uniform> <dss file="../input/RSM_TIDES_2006.dss"

pn="/NSRSM/FLAMINGO/TIDE/01JAN1983/1DAY/SIMULATED/" 
units="ft"> </dss>

</uniform>

</wallghb>
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Subtypes are used for canals and structures. They are useful for Symbology, creating maps showing 

the unique components of the model. They maintain certain rules for network connectivity. The 

subtypes provide a basic framework for editing and data validation. 
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Standard Input Files for RSMStandard Input Files for RSM

Several input files are “standard” for all RSM runs:

 ETp_recomputed_tin.bin (link to this file)

 Rain_v2.0_global.bin (link to this file)

 mannings_prop.xml (conveyance resistance 
values point to your landuse index)

 evap_prop.xml (HPM values point to your 
landuse index)

Several input files are “standard” for all RSM runs:

 ETp_recomputed_tin.bin (link to this file)

 Rain_v2.0_global.bin (link to this file)

 mannings_prop.xml (conveyance resistance 
values point to your landuse index)

 evap_prop.xml (HPM values point to your 
landuse index)
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Pre‐Processing tools have been developed using Python. 

 

 

 

The RSM GUI for Pre-Processing ToolbarThe RSM GUI for Pre-Processing Toolbar
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Create XML blocks using the RSM GUI Scenario Builder tool. 
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Scenario BuilderScenario Builder

Open the Scenario 
Builder in the RSMGUI 
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The Scenario Builder tool generates blocks of XML suitable to save as XML files, or to copy and paste 

into existing XML files. 

 Each tool area can be opened by clicking each named tab 

 Each tool consists of drop-down lists, user input fields and a help button 

 Output from each tool is generated in a text editor where the file can be saved, or copied and pasted 
to another text window 

The resulting XML block will contain RSM‐appropriate XML, saving time and avoiding costly data 

entry mistakes. 
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Scenario BuilderScenario Builder
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Subtypes are used for canals and structures. They are useful for Symbology, creating maps showing 

the unique components of the model.  

Subtypes maintain certain rules for network connectivity. They provide a basic framework for editing 

and data validation. 
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Create the PWS .XML file using the PWS tool in the RSM GUI. 

 

64

Build PWS FileBuild PWS File

Open the PWS XML 
tool in the RSMGUI 
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The PWS xml builder helps generate the PWS.XML This file contains information about each PWS 

well, the cellID it resides in, units, type and DSS path name.  

This tool requires an ASCII file containing cellID and unique well ID, which is used to construct the 

PWS.XML.  

User input options include:  

 Units 

 Type and multiplier 

 Output file type 

 File name  

 a DSS path (in the case of DSS output), used to generate the file 

The resulting output file can be edited, or copied and pasted into another XML. This tool saves a lot of 

repetitive typing and helps avoid costly data entry mistakes. 
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Build PWS FileBuild PWS File

Load .csv file 

Select timeseries
data type 

Assign path 
information 

Assign parameters 
for XML file 
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Output from the PWS tool. 
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Build PWS FileBuild PWS File
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Create a Rule Curve XML using the RSM GUI Rule Curve tool  
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Rule Curve ToolRule Curve Tool

Open the Rule Curve 
tool in the RSMGUI 
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An RSM Rule Curve XML block consists of a: 

 rcentryID 

 label 

 units 

 type  

 cycle 

 rule curve  

 date  

 elevation 

Users can choose to generate each line one‐at‐a‐time or generate a generic seasonal (wet/dry) rule 

curve. Multiple rule curves can be added and then generated into one XML. The resulting XML block 

can be saved, or copied and pasted into another XML. 
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Rule Curve ToolRule Curve Tool
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When creating a new model, you can use another subregional model or a benchmark model as your 

starting point.  SFWMD modelers can find both production and testbed models in the SFWMD SVN 

Data Repository.  External modelers can use benchmark models distributed with the RSM code.  

 

 

69

Assemble the ModelAssemble the Model

Assemble the HSE based on existing model:

 Is your model similar to one of the existing models?

 Checkout from SVN or workdirs\submodels to get started

 Setup directories for your model

 Obtain hse and hse.dtd files.

 Model

• input (store input data files)

• run_template (store main.xml)

 output (store output netcdf and dss files)

• workspace (store ancillary GIS and other data)

Assemble the HSE based on existing model:

 Is your model similar to one of the existing models?

 Checkout from SVN or workdirs\submodels to get started

 Setup directories for your model

 Obtain hse and hse.dtd files.

 Model

• input (store input data files)

• run_template (store main.xml)

 output (store output netcdf and dss files)

• workspace (store ancillary GIS and other data)
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In Lab 7 you will create a new model based on previously created files. 
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Assemble the ModelAssemble the Model

Assemble the HSE based on existing model:
 Copy your newly created input files into the input directory

 Copy .DSS files from the desired run (e.g., if you are 
implementing a Miami-Dade County subregional model, the 
time series data for that area has already been gathered)

 Copy main.xml file to use as a template

 Modify the main.xml to point to your data

 Follow the RSM Implementation philosophy: Start with limited 
features to test the model

 Make sure that path references are correct

Assemble the HSE based on existing model:
 Copy your newly created input files into the input directory

 Copy .DSS files from the desired run (e.g., if you are 
implementing a Miami-Dade County subregional model, the 
time series data for that area has already been gathered)

 Copy main.xml file to use as a template

 Modify the main.xml to point to your data

 Follow the RSM Implementation philosophy: Start with limited 
features to test the model

 Make sure that path references are correct
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Documentation is available via the HELP button on the Toolbar 
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RSM GUI DocumentationRSM GUI Documentation

RSM GUI User Guide
Available on the HELP Menu
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KNOWLEDGE ASSESSMENT 
(pre- and post-lecture quiz to assess efficacy of training materials) 
 

1. What are the two RSM GUI toolbars and how are they implemented? 
 
2. What are the key functions of the GIStoolbar? 
 
3. What are the key features in the RSM geodatabase? 
 
4. What are the necessary components for importing a mesh? 
 
5. How is a mesh populated with spatial attributes? 
 
6. What canal attributes are contained in the RSM geodatabase? 
 
7. What are canals composed of? 
 
8. What information is necessary for adding canals to the RSM canal network?  
 
9. What is the critical concern with canal network editing that is different from mesh 

editing? 
 
10.  Why is there a resegmenting tool in the GIStoolbar? 
 
11.  Which RSM features have specific XML generation utilities? 
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Answers 
 

1. The two RSM GUI toolbars are the GIStoolbar, which is implemented within ArcGIS, 
and the RSMGUI which is implemented from the Linux operating system prompt. 

 
2. The GIStoolbar is used to import the mesh, assign attributes to the mesh, and create 

XML files to run the model. 
 
3. The RSM geodatabase contains the canal and structure information for south Florida 

and the model mesh. 
 
4. The files necessary for importing a mesh are the following: mesh.2dm file, framework 

shape file and RSM template geodatabase. 
 
5. Using the Intersect tool, spatial data can be assigned to each mesh cell and using the 

Index tool, the mesh attributes can be written to an index file for an RSM model. 
 
6. The canal attributes include the cross-section properties, network connectivity, reach 

ID and segment ID. 
 
7. The RSM canals are composed of junctions and individual segments that are grouped 

into reaches and the reaches are grouped into stage-reaches that are reaches with a 
water control structure at each end. 

 
8. To add a canal (group of segments) it is necessary to have the appropriate accurate 

line-work, proper connectivity enabled, segment properties, and reach properties.  It is 
necessary to assign a value of “enabled” or “disabled” to each segment. 

 
9.  In canal network editing, to add a new canal the segmented IDs will be renumbered, 

while it is possible in mesh editing to add a cell to the mesh and assign specific cellID 
values. 

 
10. The resegmenting tool is necessary because of the complexity of adding and changing 

the topology of the segments in GIS. 
 
11.  Currently there are separate utilities to generate XMLs for public water supply wells 

and levee seepage watermovers, junction blocks, watermovers, rule curves and 
selected boundary conditions. 
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Lab 7:  Creating and modifying canal networks 

Time Estimate: 2.0 hours 

Training Objective: Gain familiarity with the canal networks within the 
RSM geodatabase and RSM GIS Toolbar 

 

The RSM GIS Toolbar is used (in ESRI ArcMap 9.2) for pre‐processing Geographic 

Information System (GIS) data and producing the XML files used by the Regional 

Simulation Model (RSM). Users are expected to have a comfortable understanding of 

basic features in ArcMap 9.2.  

Files for this lab are located in the $RSM/labs/lab7 folder. Additionally, three 
demonstration videos are available, as a supplement to this lab, for students who do 

not have access to the proprietary ArcMap software. 

  

RSM Pre-processingRSM Pre-processing
Using the RSM Graphical User Interface (GUI)Using the RSM Graphical User Interface (GUI)
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NOTE: 

 
For ease of navigation, you may wish to set an environment variable to the 
directory where you install the RSM code using the syntax 

 setenv RSM <path> 

For SFWMD modelers, the path you should use for the NAS is:  

/nw/oomdata_ws/nw/oom/sfrsm/workdirs/<username>/trunk 

setenv RSM /nw/oomdata_ws/nw/oom/sfrsm/workdirs/<username>/trunk 

 
Once you have set the RSM environment variable to your trunk path, you can 
use $RSM in any path statement, such as: 

 cd $RSM/benchmarks 

 

Training files are currently located in the following directories: 

 

INTERNAL_TRAINING 
| 
|____data 
| |__geographic 
| |__C111 
| |__rain+et 
| |__glades_lecsa 
| |__losa_eaa 
| |__BBCW 
| 
|____trunk 
| |___benchmarks 
| |___hpmbud 
| 
|____labs 
 

 

Files for this lab are located in the labs/lab7 directory.  Additional materials in the 

directory include: 

Video Files: 

Lab7_1_1.wmv 

Lab7_1_2.wmv 

Lab7_1_3.wmv 
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Activity 7.1:  Enabling and Manipulating Canal Segments 

Overview 
Activity 7.1 This activity includes two exercises: 

 Exercise 7.1.1 Become familiar with canal segments 
 Exercise 7.1.2 Add a new canal feature to the C111 RSM 

The objective of this activity is to familiarize the student with canal networks with the 

RSM geodatabase. 

Exercise 7.1.1 Become familiar with canal segments 

 
6. Open ArcGIS/ArcMap9.2 and activate the RSM GIS Toolbar.  

7. Open a New Map.  

8. Add all data from the $RSM/labs/lab7/c111.mdb catalog 

9. Arrange the layers, or turn a few layers off, until you are satisfied with how it looks, and you 

can see your mesh and canal network 

10. Save your map (.mxd) file in the lab7 folder calling it lab7.mxd 

11. Use the ESRI Identify Tool  and click on features in the map 

12. Select a structure and view the attributes and associated tables 

13. Select a canal segment and view the attributes 

 

HINT 

 

In ArcMap select Tools > Customize > RSM GIS 
ToolBar v4.3. The toolbar is now part of your ArcMap 
settings. 
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Figure 7.1  Select by Attributes dialog box 

 
14. From the Selection Menu, open the Select by Attributes dialog box (Fig. 7.1) 

15. Select [reach] = 617 

16. Zoom to the selected features and right-click the Canal layer in the attribute window (on the 

left side of your screen) to view the attribute table for the canal layer (Fig. 7.2) 

17. Use the option at the bottom of the attribute window to show selected records 

 

 

Figure 7.2  Open Attribute Table for Canal layer 
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HINT 

 

You must be in an edit session to change attributes. 
There should be two records in your selection. 

 
 How many segments are now in Reach 617? 
 What is the bottom width? 
 What is the Manning’s coefficient? 
 Select mesh cell_id=2783 
 What is the topo elevation? 

 
18. Select [reach] = 598. View the attribute table for the Canal layer. Use the option to 

only show selected records. 

HINT 

 

You must be in an edit session to change attributes. 
There should be one record in your selection. 

 
19. Click on the Editor toolbar to start editing.  In the Attributes of Structure 

Table, ‘disable’ the segment in Reach 598 by changing the ‘enabled’ attribute to “false” 

(Figure 7.3). Save your edits. 

Figure 7.3  Disabling Reach 598 in the Attributes of Structure table. 
 

20. Select the Index Tool from the HSE Network Menu in the RSM GIS ToolBar  

21. Choose the Canal layer and click the CanalId attribute  

22. Using the Index Tool, specify the Canal Index Header under the Header Type and 

click the Create Index File button to generate a canal index file 

23. Provide a location and name to save the file 

24. Open the file using Textpad (or any text editor). 

 What is the first CanalId listed in the report right after the header? 
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Figure 7.4  Segmentation Tool dialog box 

 
25. While working in your lab7.mxd map, open an Edit Session 

 Select [reach] = 617 
 Zoom to the selected features 
 Use the Segmentation Tool to Segment Interactively the reach specifying (as shown in 

Figure 7.4): 

 Minimum: 1500 
 Target: 3000 
 Maximum: 5280.  

 Refresh your screen and view the attribute table for the canal layer 

 

HINT 

 

1. Remember to save your edits. 
2. You may need to activate the Editor toolbar.  

 
 How many segments are now in Reach 617? 
 What is the resulting length of the segments in Reach 617? 
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Figure 7.5  Canal reach 617 after editing (highlighted in turquoise). 
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Exercise 7.1.2 Add a new canal feature to the C111 RSM 

 
26. Open lab7.mxd in ArcMap 

27. Select canal segment with canalId= 309549 

28. Add a new canal at that location (in Editing mode, as shown in Fig. 7.6) 

 

Figure 7.6  Adding a new canal segment to intersect with canalId 309549. 

 

29. Click Start Editing in the Editor Toolbar  

 (Make sure the Target is the canal Layer and Task is Create new feature) 

30. Select the Pencil tool and draw your four new segments  

 Click the F2 key at the end of each segment to end the segment and start a new one 
 After adding the segments remember that canal segments must break at intersections. 

Use the Line Split Tool to split necessary segments at intersections. 

Segment 1 should intersect the C‐111 Canal at canalId 309548. 

31. After your new segments are drawn, open the Attributes of Structure Table 

from the Table of Contents (on left side of screen)  
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32. Edit the segment field attribute values: 

 Field Attributes Values 

 BOT_WIDTH BOT_ELEV SIDE_SLOPE Mannings 

Segment 1 56 -2.2 2 0.04 

Segment 2 45 -2.4 2 0.04 

Segment 3 40 -2.7 2 0.04 

Segment 4 36 -2.9 2 0.04 

 
33. Assign all of the new canals to a new reach. (The reach number should be the next highest 

number in the sequence of reach numbers.) 

 Assign a new reach number where necessary. 
 Symbolize canal segments by reach to display the new reach or reaches. 

34. Once all changes and additions are final, end your editing session by clicking the Save 

Edits button in the Editor Toolbar.  

35. Add a new structure, Name = Spillway1, between Segment 3 and Segment 4 in 

your new canal. The new structure should be Flow = Inline Structure with 

WM_type = Structure_Flow and struc_type = spillway.  

 How many Inline structures are now in the model? 
 Since the structure has been added, is your new reach still valid?  

 
36. Since your new structure is a spillway it must be added to the related Spillway table. Add 

this entry into the related table and set the dis_coef = 2000. (There is more than 

one way to do this.) 

37. Identify Spillway1 to display the new spillway properties and include a screen capture. 

 
 

HINT 

 

Search for relationship class editing in ArcMap Help. 
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Activity 7.2:  Construct a Canal Network from the SFRSM Template Network 

Overview 
Activity 7.2 This activity includes two exercises: 

 Exercise 7.2.1 Clip the canal network to the EAA RSM Mesh 
 Exercise 7.2.2 Add network boundary conditions 

When it is necessary to create a new subregional RSM implementation within the 

SFRSM domain or create a new canal network, it is best to begin with the SFRSM 

template geodatabase. The template contains the complete primary canal system with 

canal properties and associated structures. The objective of this activity is to create a 

canal network from the SFRSM template canal system for a user‐provided mesh using 

the RSM GIS ToolBar. 

Exercise 7.2.1 Clip the canal network to the EAA RSM Mesh 

 
38. Open New Map in ArcMap 

39. Open RSM GIS ToolBar > Mesh Menu > Import Mesh > Load SFRSM Template (Fig. 7.7) 

Figure 7.7  Load SFRSM Template for Mesh 

 
 
 

40. Import the eaamc3.2dm file (as described in Lab 6, Exercise 6.1.2  Import a mesh into 

the RSM) 

41. Create the output geodatabase: eaamc3.mdb 

42. Close ArcMap 

After importing the mesh, the geodatabase will contain a canal layer. The CanalId 

Index must be removed before proceeding so that the RSM can reset the segment 

IDs for the new canal network. 
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Figure 7.8  Opening eaamc3.mdb from ArcCatalog 

 
43. Open new ArcMap >  Open ArcCatalog > Open eaamc3.mdb (Fig. 7.8) 

44. Open sfrsm_gis > Select canal feature class> Right-click to open properties (Fig. 7.9) 

 

Figure 7.9  Opening the canal feature class properties in Arc Catalog. 
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Figure 7.9 (cont.) Opening the canal feature class properties in Arc Catalog. 

 
 

45. In the ArcCatalog Feature Class Properties interface, click the Indexes Tab 

46. Select the CanalId attribute index (see Fig. 7.9) and click the Delete button. (If the Delete 

button is not highlighted, close out of ArcMap and repeat.) 

47. Click the Apply button (located at the bottom of the window), and then click the OK button. 

48. Return to ArcMap and your geodatabase.  

After importing the mesh, your canal layer will include all of the canals from the 

SFRSM_Template geodatabase that intersect with your mesh including one or two 

segments outside of your mesh. There may be structures just outside of the mesh that 

are desirable to include in the model and this allows the modeler to select which 

segments to include. 

You are now ready to generate your .MAP file. First, it is necessary to edit the Canal 
Feature Class: 

49. Open a new ArcMap 

50. Add mesh, structure and canal feature classes from eaamc3.mdb 

51. Save as eaamc3.mxd 

52. Start an Editing session for your Canal Feature Class (see Fig 7.10). 
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Figure 7.10 Starting to edit the eaamc3.mxd file. 

 
53. Identify the features that extend outside your mesh boundary and determine which features 

should be clipped or simply moved back across the boundary.  

 If the canal goes over the boundary and comes back in, you should move it back within 
the boundary. You should only move the canal if it only slightly extends over the 
boundary.) 

54. At the north end of the eaamc mesh the canal is outside of the mesh (see Fig 7.11). Use 

the Selection Tool to grab the canal segment and pull it back into the mesh (see Fig 7.12) 
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Figure 7.11 Canal is outside the mesh boundary. 

Figure 7.12 Canal segment pulled back in, plus Split Tool button on the Editor Toolbar. 
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55. Once the features that need to be clipped have been identified, use the Split Tool button on 

the Editor Toolbar (located to the right of the Target list box; see Fig 7.12). 

 

 

Figure 7.13 A mesh framework with segments extending outside the boundaries. 

 
56. Delete the portion outside of the boundary.  

 

HINT 

 

Although it is tempting to delete any segments you may 
not want to include in the current model, it is better to 
keep the segments and simply disable them. 

 
57. In the Editor drop-down menu, click Save Edits to save the modifications to the Canal 

Feature Class in eaamc3.mdb 

58. If you chose to move the feature back inside the boundary, select Modify Feature from the 

Task list box in the Editor Toolbar, and use the Arrow tool to select and drag the vertices 

back inside the boundary (see Fig. 7.13). 

 

Splitting tool

Select and
delete 
extraneous
segments

Splitting tool

Select and
delete 
extraneous
segments
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59. Once all the nodes are inside the boundary, click the editor button and Save Edits. 

60. Stop Editing. (This command is also located in the Editor drop-down menu.) 

61. Export the map file: RSM GIS Toolbar > HSE Network Menu > Index Tool 

62. Save your map and start a new map 

63. Select the RSM GIS Toolset v4.3 Tab 

64. Select Generate XML >  Canal File (*.MAP) 

65. Complete the Create Canal Map File data fields (refer to Fig. 7.14)  

 Enter the Canal Feature name and destination (eaamc_canal.map) 
 For Filter 1, select Enabled and value = True 
 For Filter 2, select Canal_type and value = canal 
 Click the Ok button 

 

Figure 7.11  Create Canal Map File window 
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66. List the eaamc_canal.map file and examine the contents  

 Notice that there are several vertices in each of the segments 

67. Examine the canal properties (see Fig 7.15). In ArcMap, select a canal segment.  

 The segment properties include the Mannings roughness, canal-aquifer leakage, and 
canal-overland flow coefficient. Values for these parameters have been tabulated for all 
canals as part of the subregional RSM implementations. The segment properties are 
typically listed in the main XML file.  

 

 

Figure 7.15  Canal properties for a selected canal segment (CanalId=310427) 
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Exercise 7.2.2 Add network boundary conditions 

 

Typically the upstream flow boundary condition (BC) and the downstream head 

boundary conditions are provided as time series of daily values at each location point 

(see Fig 7.16). Downstream BCs can be converted from constants to time series based 

on observed historical head and flow data (see example XML in Fig 7.17). 

68. Open the Everglades Agricultural Area-Miami Canal (EAA-MC) Basin model file 

(eaamc_sp.xml) in the labs/lab6_GMS directory 

69. Add a segment source boundary condition to the model for the upstream boundary 

conditions using the time series available for the S3 structure from the SFWMM dataset: 

$RSM/data/losa_eaa/input/flow_v5.0_09292003.dss. 

 

Times series of daily flow at S3 Time series of daily head at S8 

Figure 7.16 Examples of daily flow and head at structures S3 and S8, respectively. 

 

70. Add a segment general head boundary condition to the model for the downstream boundary 

segment using observed data for the S8 structure: 

$RSM/data/losa_eaa/input/eaa_obs_canal_stage.dss 

 Set the conductivity to 0.0001. 
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<segmentghb id="300007" bcID="1" kcoef="0.0001" label="S8(GHB)"> 
      <dss file="./input/eaa_obs_canal_stage.dss" 
         pn="/SFRSM/S8H/STAGE//1DAY/OBS/" 
         units="FT" type="PER-AVER" mult="1.0"> 
      </dss> 
   </segmentghb> 
 
<segmentsource id="300001" bcID="2" label="S3"> 
     <dss file="./input/flow_v5.0_09292003.dss" 
          pn="/SFWMM/S3/FLOW//1DAY/HISTORICAL/" 
          units="cfs" type="PER-AVER" mult="1.0"> 
     </dss> 
</segmentsource> 
 

Figure 7.17 Example XML for segment general head boundary and segment 
source boundary conditions at two structures. 

 
71. Change the “runDescriptor” in the <control> block to “canal” 

72. Save the model as: $RSM/labs/lab6_GMS/eaamc_spc.xml 

73. Run the model using the RSM GUI and observe the changes in the head values in the cells 

and segments. 
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Answers for Lab 7 

Exercise 7.1.1 
12. # of segments in Reach 617 = 2 

bottom width = 24 

Manning’s coefficient = 0.07 

mesh cell_id 2783 topo elevation = 2.8038 

19. First CanalId after header = 309,503 

20. # of segments in Reach 617 = 5 

length of segments in Reach 617 = 3130.64 

Exercise 7.1.2 
10. # of inline structures = 5 

Is the new reach still valid? Yes  

Exercise 7.2.1 
Compare results with those in the lab7 directory 

Exercise 7.2.2 
Compare results with those in the lab7 directory 
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Wetlands ............................................. 76 
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calibration ......................................... 24, 59 
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reach ....................................... 28, 31, 34 
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heads .................................................. 59 
ID .................................................. 79, 95 
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74, 79, 93, 95 

coefficient ......................................... 79, 95 
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conductivity ................................... 59, 92 
control ......................................... 56, 74, 93 
coordinates ............................................. 32 
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daily values ............................................. 92 

datasets .................................................. 49 
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dis_coef = ............................................... 83 
downstream head boundary conditions .. 92 
DSSVue ................................................. 49 
EAA ........................................................ 84 
Editor toolbar ....... 12, 79, 80, 82, 83, 88, 89 
environment variable .............................. 76 
error ........................................................ 53 
ESRI ................................................. 75, 77 
Everglades Agricultural Area .................. 92 
Everglades Agricultural Area-Miami Canal 

(EAA-MC) Basin ................................. 92 
F2 ........................................................... 82 
feature class .......................... 42, 43, 85, 86 

canal ............................................. 86, 89 
properties ............................................ 86 

file format 
ASCII ...................................... 38, 45, 66 
DSS ........................................ 66, 92, 93 
NetCDF ............................................... 37 
XML ................. 48, 49, 57, 59, 66, 92, 93 

Filter 1 .................................................... 90 
Filter 2 .................................................... 90 
flow .......... 20, 35, 42, 49, 54, 58, 83, 92, 93 
framework ........... 17, 20, 42, 60, 64, 74, 89 
gage ....................................................... 59 
geodatabase .. 3, 6, 7, 9, 10, 12, 17, 29, 30, 

36, 37, 38, 40, 41, 44, 45, 52, 74, 84, 86 
geodatabase_template ............................. 7 
GMS ............................ 7, 17, 27, 37, 92, 93 
groundwater ........................................... 42 

flow ..................................................... 42 
gw, see groundwater .............................. 42 
head ........................................... 38, 92, 93 
Header Type .......................................... 79 
HELP button ........................................... 72 
HINT ................................ 77, 79, 80, 83, 89 
historical data ......................................... 92 
how to 

add a new canal feature to the C111 
RSM .......................................... 77, 82 

add a new structure ............................ 83 
add a segment general head boundary 

condition .......................................... 92 
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complete primary canal system with 
canal properties and associated 
structures ......................................... 84 

convert from constants to time series 
based .............................................. 92 

create a canal network from the SFRSM 
template canal system for a user-
provided mesh using the RSM GIS . 84 

create a new subregional RSM 
implementation ................................ 84 

create the output geodatabase ........... 84 
display a new reach ............................ 83 
display a new spillway’s properties ..... 83 
edit a canal feature class .................... 86 
Export a map file ................................. 90 
generate a .MAP file ........................... 86 
grab the canal segment ...................... 87 
import a mesh into RSM ............... 84, 86 
open a new map ........................... 77, 84 
open an edit session ..................... 28, 80 

HPM ............................................... 6, 7, 76 
hub ................................................ 23, 24 
water budget ....................................... 76 

HSE ........................ 6, 7, 27, 34, 57, 79, 90 
network ......................... 6, 27, 34, 79, 90 

hydraulic conductivity ....................... 24, 25 
hydraulic conductivity zones ................... 25 
Index Tool ............................. 38, 55, 79, 90 
initial head .................................. 32, 37, 38 
inline structures ................................ 54, 83 
input data 

boundary conditions 7, 32, 33, 42, 58, 74 
flow ..................................................... 92 
mesh ................................................... 74 

input data, canal attributes ............... 73, 74 
input files 

initial conditions ................................... 32 
map file ................................... 33, 37, 40 

Input FrameWork Shapefile .................... 17 
landuse ............................................. 22, 23 
Layer .................................... 11, 18, 28, 82 
levee ................................................. 58, 74 
levee seepage, see also seepage .......... 74 
Linux ....................................................... 74 
main XML file .......................................... 91 
make, see makefile ........... 1, 11, 12, 38, 58 
Mannings .................................... 28, 83, 91 

mesh 5, 7, 9, 10, 15, 17, 18, 20, 21, 22, 23, 
24, 32, 37, 38, 42, 47, 50, 58, 73, 74, 77, 
79, 84, 86, 87, 88, 89, 95 
attributes ............................................. 74 
import ............................................ 17, 84 
mesh-centered .............................. 22, 23 
node ....................... 18, 37, 42, 58, 59, 90 

mesh_framework .............................. 18, 58 
Modify Feature ....................................... 89 
MSE ..................................................... 6, 7 
network .......... 10, 21, 53, 60, 64, 74, 84, 92 

boundary condition ....................... 84, 92 
new ArcMap ..................................... 85, 86 
note .. 2, 3, 6, 20, 21, 33, 40, 44, 53, 54, 57, 

59, 76 
output data .............. 5, 6, 37, 38, 47, 53, 66 
overland flow .......................................... 42 
parameter ................................... 24, 32, 91 
pre-processing Geographic Information 

System (GIS) data .............................. 75 
public water supply, see also pws .......... 74 
pump, see also watermover ............. 53, 57 
pws ...................... 46, 48, 49, 50, 65, 66, 67 
Python ............................................ 1, 5, 61 
rainfall ..................................................... 76 
reach . 29, 31, 34, 74, 78, 79, 80, 81, 83, 95 
reach number ......................................... 83 
reference 

HSE User Manual ............................... 57 
Lal ....................................................... 36 

Regional Simulation Model, see also RSM
.................................................... 1, 5, 75 

relationship class editing ........................ 83 
RSM 

geodatabase . 6, 7, 17, 28, 30, 40, 73, 74, 
75, 77 

implementation ............................. 25, 91 
RSM GUI ..... 1, 5, 17, 62, 65, 68, 73, 74, 93 

GIS ToolBar .... 1, 2, 5, 6, 7, 9, 10, 11, 14, 
15, 17, 28, 29, 30, 31, 34, 45, 46, 55, 
74, 75, 77, 79, 84, 90 

toolbar ................................... 3, 5, 37, 74 
RSM, see also Regional Simulation Model

.. 1, 2, 3, 5, 6, 7, 9, 14, 15, 17, 18, 20, 21, 
25, 28, 30, 34, 37, 38, 39, 40, 49, 52, 53, 
56, 57, 59, 62, 63, 65, 68, 69, 70, 73, 74, 
75, 76, 77, 79, 84, 90, 91, 92, 93 

runDescriptor .......................................... 93 
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Save Edits button ................................... 83 
segment 

attributes ....................................... 74, 91 
boundary condition ........................ 92, 93 
segmentsource ................................... 93 

segment, see also waterbody 
segment ... 10, 15, 28, 29, 32, 33, 34, 35, 

36, 37, 41, 54, 74, 79, 80, 82, 83, 84, 
86, 88, 89, 91, 92, 93, 95 

Segmentation Tool ..................... 34, 36, 80 
Select by Attribute ................ 11, 31, 34, 78 
Select by Attributes ........................... 11, 78 
setenv ..................................................... 76 
SFRSM ................................. 17, 84, 86, 93 

geodatabase ....................................... 86 
geodatabases ..................................... 84 

SFWMM ........................................... 92, 93 
dataset ................................................ 92 

shape file ................................................ 74 
sideslope ................................................ 83 
spillway ................................................... 83 
Spillway1 ................................................ 83 
stage ............................... 29, 38, 74, 92, 93 
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